SLIDE 1
Is My Agency Accessible?
Does It Have to Be?
Donna Lettow
MSDE Division of Rehabilitation Services
Digital Accessibility Administrator
Donna.Lettow@maryland.gov

SLIDE 2
“Accessible” Something that is:
- Obtainable
- Usable
- Understandable

SLIDE 3
Accessibility in the “Built Environment”
Graphics:
- accessible public restroom
- Push to Open button for an automatic door
- Braille and Picture Menus Available sign
- Blind woman with a cane navigating a curb cut
- Accessible drinking fountain
- Ramp leading into a building

SLIDE 4
“Digital” Accessibility?
Communication/Information that is:
- Obtainable
- Usable
- Understandable

SLIDE 5
US Department of Justice says:
A person with a disability can:
- acquire the same information
- engage in the same interactions
- enjoy the same services
as a person without a disability...

SLIDE 6
Acquire the Same Information
Graphic: Logo: Maryland State Department of Education. Achievement matters most.
Graphic: Logo: Maryland State Department of Education. Equity & Excellence.

SLIDE 7
Engage in the Same Interactions

SLIDE 8
Enjoy the Same Services
Graphic: Netflix logo. Harvard University logo.

SLIDE 9
US Department of Justice says:
…in an equally effective and equally integrated manner, with substantially equivalent ease of use.
Graphic: Workday logo. Gmail logo. Google Calendar logo.
SLIDE 10
US Department of Justice says:
The person with a disability must be able to obtain the information or perform the task as fully, equally and independently as a person without a disability.
Graphic: PetSmart logo.

SLIDE 11
Who Benefits from Accessibility?
Graphic: A man working in front of a computer with headphones and a refreshable Braille display attached to his keyboard.

SLIDE 12
Information Blind User Gets:
“Blank.”

SLIDE 13
Information Sighted User Gets:
Graphic: Maryland State Department of Education Office of Human Resources memo. Subject: Reasonable accommodations for individuals with disabilities policy. A paper document was scanned as an image, not OCR’ed or tagged as an accessible PDF.

SLIDE 14
Information Blind User Gets:
Please read this very important message:
To continue, hit ENTER.

SLIDE 15
Information Sighted User Gets:
Please read this very important message:
Graphic: All of your email is about to be deleted!
To continue, hit ENTER.

No alternate text in the document/code to convey to a blind user what this graphic – literally a picture of text, not actual text – tells a sighted user

SLIDE 16
Information Blind User Gets:
Audio: Happy whistling music.

SLIDE 17
Information Sighted User Gets:
Audio: Happy whistling music.
Video: A cartoon of a woman waving. Then, over a large crowd of cartoon people, the words "Employees Matter. Employees are our most valued resource."

SLIDE 18
Information Blind User Gets:
“Edit. Type in Text.”

SLIDE 19
Information Sighted User Gets:
Graphic: Section of an online form. Sign in: Asterisks indicate required information. Social Security Number *. XXX-XX-Last 4 digits. In the form field, the placeholder text Last 4 digits.

Form fields aren’t labeled properly to tell the blind user what text to type in the fields, so all the screen reader can tell them is: “Enter. Type in Text.”
SLIDE 20
Who Benefits from Accessibility?
Graphic: A woman works at a computer whose monitor is showing enlarged print.

SLIDE 21
Information Low Vision User Gets:
Graphic: A gray box.

SLIDE 22
Information Sighted User Gets:
Graphic: A lime green box with words in pink: The deadline for registration is June 15th.

Poor color contrast. Contrast has to be a ratio of 4.5:1 or better for people with low vision to be able to read it well. This is only 1.5:1.

SLIDE 23
Who Benefits from Accessibility?
Graphic: Ishihara Color Blindness Test Plate, the number 12 in orange dots surrounded by dark gray dots.

SLIDE 24
Information Colorblind User Gets:
Graphic: Grayscale Table. The columns are headed Project, Due Date and Completed. Web comparison report September 15 X. Webinar materials September 20 X. Survey questionnaire September 23 X.

SLIDE 25
Information NON-Colorblind User Gets:
Graphic: Color Table. The columns are headed Project, Due Date and Completed. Web comparison report September 15 Green X. Webinar materials September 20 Red X. Survey questionnaire September 23 Red X.

SLIDE 26
Information ALL Users Can Get:
Graphic: Color Table. The columns are headed Project, Due Date and Completed. Web comparison report September 15 Green Y. Webinar materials September 20 Red X. Survey questionnaire September 23 Red X.

SLIDE 27
Who Benefits from Accessibility?
Graphic: A man conducting a job interview with a woman. The woman is signing. Between them, a computer monitor showing the remote ASL interpreter.
Graphic: An older woman puts in a hearing aid.

SLIDE 28
Information Deaf User Gets:
Video without sound. A man crosses a street into a building. As the doors open and camera walks across the lobby, onscreen graphic reads "June 26, 2015. 801 W. Baltimore St., Baltimore, MD. Baltimore City Community College Campus. @ University of Maryland Biopark."
An outline of a body drawn on paper on a floor. There are three wrenches around the outline. Police tape. A Tennis shoe with toes tapping. A women in gardening gloves with a trowel. A woman in an apron and chef's hat.

SLIDE 29
Information Hearing User Gets:
Video with sound. Video is same as above.
Woman's voice: Biotechnology and forensics. That's what we are here for. We are here to tell them what's the next level they can reach to.
Male narrator: At the University of Maryland Biopark in West Baltimore, the Maryland Summer Centers opens the doors to the gifted and talented summer camp. Inside the lab, the students dig into the study of forensics. They concoct a murder. The suspects: The Gardener. The Chef.

Videos must have synchronized captions, as well as a written transcript or audio track describing what's onscreen for the blind.

SLIDE 30
Information Deaf User Gets:
Graphic: Section of YouTube video showing the closed captions. The caption reads: “…how to use fellows for evaluations and to ensure they are tall…”

SLIDE 31
Information Hearing User Gets:
"… how to use S.L.O.'s for evaluation and ensure they are a tool for…”

YouTube's “automated captioning” is notoriously inaccurate. When Google’s robots try to guess what your speakers are saying, they will guess WRONG!

SLIDE 32
Who Benefits from Accessibility?
Graphic: A deaf-blind man reads a Braille display with one hand while his assistant signs into his other hand.

SLIDE 33
Who Benefits from Accessibility?
Graphic: A man at a computer. He is wearing a microphone and an appliance that allows him to use the keyboard with a head stick.

Graphic: Man wearing headset and dictation microphone.

SLIDE 34
Information a User Who Can’t Use a Mouse Gets:
From an online course in Maryland schools:
Graphic: Screen shot: Essential Questions. How does the use of computers support how we live today? What changes in infrastructure have occurred because of innovation in computer devices? What is the Digital Divide and how does it affect a person's ability to compete in today's global marketplace? The words Digital Divide are in green.

SLIDE 35
Information a User Who Uses a Mouse Gets:
Graphic: Same screen shot, but a pop-up box has appeared over the text that reads Digital Divide: The virtual line between people and cultures that have access to computers and those who do not.

Students who can't use a mouse and must navigate using the keyboard can't access important definitions by hovering with a mouse.

SLIDE 36
Functionality a User Who Can’t Use a Mouse Gets:
Graphic: Screen shot: A table with column headers PLUS SIGN, Time Type, Time off Reason. In. Out. Below is a row that says No Data.

SLIDE 37
Functionality a User Who Uses a Mouse Gets:
Graphic: Screen shot of table with same column headers, showing two additional rows with Time Type Exempts: Regular, and In and Out times.

People who can't use a mouse because of mobility issues or because they're blind can't activate the PLUS SIGN button that lets them enter their time into their company's payroll system.
SLIDE 38
How does this apply to me and my agency, organization, CRP?

SLIDE 39
Are You a Federal Agency?
Are You a Federally Funded Program?
Section 508 of the Rehabilitation Act of 1973, as amended (29 U.S.C. § 794 (d))

SLIDE 40
Are You a Maryland State Agency?
Maryland IT Nonvisual Access Regulatory Standards (COMAR 14.33.02.01-.12)

SLIDE 41
I’m Not a Government Agency, so I’m Exempt, Right?

SLIDE 42
Americans with Disabilities Act (ADA)
  • Title I: Employment
  • Title III: Public Accommodations & Commercial Facilities

SLIDE 43
How Can I Check My Website?

SLIDE 44
Tab – Space Bar - â - á - Esc
The No Mouse Challenge nomouse.org
Put aside your mouse and see if you can use your website just by moving around with the keyboard.

SLIDE 45
No Mouse Challenge
  • Can I access all features?
  • Can I operate all the buttons, sliders, and other controls?
  • Can I easily tell where I am on the page?

SLIDE 46
No Mouse Challenge
  • Example 1: DORS Website dors.maryland.gov
  • Example 2: Humanim Website www.humanim.org

SLIDE 47
Manual Media Checks
  • Do videos have captions?
  • If so, are they accurate?
  • Are audio descriptions or written description documents also available?

SLIDE 48
Manual Media Checks
  • Example 1: DORS Website dors.maryland.gov/consumers/benefits/Pages/SSI_SSDI.aspx
  • Example 2: National Parks Service Website nps.gov/media/video/view.htm?id=ED6D94AF-07E4-5C42-CCEE7C0991198701

SLIDE 49
Alternate Text
Does the graphic have alternate text?
Does the alternate text give the blind user the same information the sighted user gets from the graphic?
SLIDE 50
Alternate Text
Graphic: The head of an otter pokes up out of the water.
  • alt="Partially submerged otter"
  • alt="sandiego-zoo_otter57.jpg"

SLIDE 51
Testing Toys
Graphic: The URL and bookmark bar of the Firefox web browser. An arrow points to an icon that is a color wheel with a checkmark on it, Contrast WCAG. On the bookmark bar are buttons for Alt Tags and Gray Scale.
DORS Website > Resources > Presentations > MSDE Accessibility Materials
or go.usa.gov/xEEBH
FireFox browser preferred

SLIDE 52
Alt Tags
  • Example 1: MSDE Publications Website
    marylandpublicschools.org/about/Pages/OCP/Publications/index.aspx
  • Example 2: The Arc Baltimore Website thearcbaltimore.org

SLIDE 53
Grayscale
How difficult is the text to read in grayscale?
Graphic: Screen shot. On a medium gray background, white text reads Select Your Interests. Human Services. Workforce Development. Social Enterprise. In the next column, in white text on a light gray background, the words donna.lettow@maryland.gov is already subscribed to list Website Subscribers.
Graphic: On a black background, the words in light gray 2019 ServiceSource. All Rights Reserved. Image of a dot, space, then another dot. On the next line, the words Strengthened by.

SLIDE 54
WCAG Contrast Checker
Graphic: On a yellow background, white text reads Select Your Interests. Human Services. Workforce Development. Social Enterprise. Next to it, another screen shot that shows the contrast ratio between the yellow and white is 1.68 and fails color contrast testing.
Graphic: In white text on a light gray background, the words donna.lettow@maryland.gov is already subscribed to list Website Subscribers. Next to it, another screen shot that shows the contrast ratio between the gray and white is 1.4 and fails color contrast testing.

SLIDE 55
WCAG Contrast Checker
Graphic: On a black background, the words in light gray 2019 ServiceSource. All Rights Reserved. Image of a gray dot, in red the words Privacy Policy, then another gray dot and the words DMCE Policy in red. On the next line, the words Strengthened by in gray and Alliant Studios in red.
Under it, another screen shot that shows the contrast ratio between the black and red is 3.14 and fails color contrast testing.

SLIDE 56
Documents
  • If a document/attachment is on your website, it must be accessible, just like the web pages themselves must be accessible.
  • If you’re distributing a document and you don’t know all the potential recipients personally, it must be accessible.
SLIDE 57
Testing Toys
Microsoft Office Accessibility Checker
Graph: Screen shot Microsoft Word Accessibility Checker, showing the Check for Issues and Check Accessibility buttons highlighted on the FILE screen.
File > Check for Issues > Check Accessibility

SLIDE 58
Graph: Screen Shot: A Word document with a graphic in it and the inspection results of the accessibility checker, showing a list of the images with missing alt text and information on how to fix the errors.

SLIDE 59
PDFs
Rule of Thumb: If a document passes the Word Accessibility Checker, the resulting PDF should be accessible.

SLIDE 60
Adobe Reader/Acrobat Read Out Loud
Graph: A PDF open in Adobe Reader Showing the Read Out Loud buttons highlighted.
View > Read Out Loud > Activate Read Out Loud
View > Read Out Loud > Read...

SLIDE 61
Read Out Loud
- Example 1: Accessible PDF Pulse012019.pdf
- Example 2: Scanned PDF Pulse012019-scanned.pdf

SLIDE 62
“Scan to PDF”
A scanned paper document is generally NOT accessible.
It is a photograph of a piece of paper.
Graphic: Antique camera

SLIDE 63
“Generally?”
There are exceptions:
- See if scanner can be set to do “OCR” (Optical Character Recognition) or create a “searchable” PDF.
- Scan directly from Adobe Acrobat, set configuration for OCR or “searchable.”
Both require crystal clear, crisp, legible, sharp paper documents!

SLIDE 64
Accessible Forms
If you expect people to print your form and fill it out with a pen on paper, it's not accessible.

SLIDE 65
Accessible Forms
If you type some words and some lines in a Word document, that's still not an accessible form.
Graphic: Screen shot of a Word document that looks like a form, with lines drawn to write on.

SLIDE 66
Accessible Forms
It's just a mess.
Graphic: Same Word document, with information typed in so that the lines spill over onto other lines and the form loses its format.
SLIDE 67
Accessible Forms
If you put fillable form fields in a Word document so it can be filled in on a computer and used by a screen reader, that’s an accessible form.
Graphic: Same form, done as accessible Word form, with form fields.

SLIDE 68
Accessible Forms
Consider using an accessible survey service like SurveyGizmo or Survey Monkey.
Graphic: Screen shot from SurveyGizmo survey asking for zip code and county of residence.

SLIDE 69
Questions?